
Acoustica MP3 CD Burner 4. 0 Help
Why limit your MP3s to your computer?  
Burn music & MP3 CDs.  Trim, fade or boost your songs!   Squeeze 200 MP3s on a 
CD or 1000 on a DVD!  What's new in this version? 

  Find Your Songs 

 

Your Music Library 

 Rip Your CDs Play Your Songs 

Arrange Your Songs   Burn A CD! 

Buy a registration code and unlock the software for 
unlimited usage! (If you haven’t already! � )

Preferences 
Menu Help 
Toolbar Help
Support 
Troubleshooting
Acoustica Information 

Acoustica MP3 CD Burner © 1997-2004 Acoustica. All Rights Reserved.
Ogg Vorbis © 2004, Xiph.Org Foundation 
Many thanks to the LAME team for their work on the LAME encoder.  See their 
website at mp3dev.org/mp3/ 



Buy / Registration
Acoustica MP3 CD Burner has a trial period of 7 days without any restrictions!  After 
that, you will need to purchase a registration code to continue using the software.

 

Please don’t let the above happen to our programmers! �  All joking aside, we have 
put many hours into this software and we hope that you decide to purchase the 
software!
Benefits of Registration

• Unlimited and unrestricted usage: burn & rip away! 

• Support Acoustica and future products of the same caliber.

You can purchase a registration code right now and automatically receive a 
registration code in your email within minutes.  

BUY NOW! 

To purchase a registration code, click the "Buy Now On-line" item from the "Help" 
menu or the "BUY" button on the toolbar.

If you don’t have the software up now, visit the website to purchase a code.  Go to 
www.acoustica.com 

Purchase methods

• Credit card

• Pay pal

• Snail mail



The price of registration is not much more than the cost of a large pizza!  The price 
may actually vary which is why it isn’t listed here.  (More instructions are on the 
website.)



Acoustica, Inc
Address: Acoustica

P.O. Box 728
Oakhurst, CA 93644
USA

Website: www.acoustica.com 

Info: Acoustica was founded in 1998 and is located in 
the foothills of the Yosemite Valley.   Acoustica's 
mission is to create high quality, intuitive and 
powerful software.  We value diligence, creativity 
and innovation.  We are embracing Internet 
technology and the new world that it is 
creating! We also have this curious idea that 
SOFTWARE SHOULD BE EASY TO USE! �

      



System Requirements
Operating System : Win95/Win98/WinNT/WinME/Win2K/WinXP
Recommended processor : Pentium II 400 or better**
RAM                                : Uses about 3-4 MB’s of RAM
Soundcard                       : optional
CD Recorder : recommended. (USB/SCSI/IDE).  See list. 

  Hard-disks : If converting to WAV first, it requires up to 700 MB 
free

** AMD based systems are also supported.  Slower systems will find that it works fine



Support
For the most recent support information, please see the website. 
http://www.acoustica.com/mp3-cd-burner/support.htm 



What’s New?
This section contains the new changes, additions, and fixes from previous versions.  
(We started this for version 2.998 of the software.)

Version 4.0
• New burning engines. More supported recorders!

• Burn on fly for Goldenhawk engine!  No more converting to WAV!

• Automatic fading out for incomplete songs

• Can trim songs to cut unwanted silence or applause, etc.

• Fade in/out and overlap tracks to create the ultimate in custom mixes.

• Automatic boost for better volume balancing - 

• EQ each song and burn them that way.

• OGG support

• Brand new 32 bit sound engine – high quality for superior audio results.  Even low bitrate files 
will not degradate in quality.

• Much improved ‘import’ / sound scan system.

• Can now set which columns you see in the "Song List"

• Ability to delete database

• "Add All Found" button on find interface.

• Visual waveform eye-candy on player window.

• Interface improvements

• Important bug fixes – including some serious bug fixes.

Version 3.01 build 66
• Detached Gear engine from main install – it is now an optional installation.

• New Goldenhawk engine 3.9F – more supported recorders.

• Bug fixes

Version 3.0 
• MAJOR Update!  Now supports MP3 CDs!  Fit 200+ songs on a CD or 2000+ songs on a DVD!  

Note that you will need an MP3 player capable of playing MP3s, WMAs and/or WAVs.  
Computers will also be able to play back MP3 CDs!

• More supported CDRW drives and DVD burners with both engines (Gear & Goldenhawk)!

• Progress/fill meter shows you visually how much room you have left on the CD!

• New splash screen

• Important fix for some recorders that would not ‘finalize’

• Bug fixes!

Version 2.998
• Brand new – high end CD burning/ripping.  This engine includes automatic support for new CD 



recorders and burning CDs on the fly.  No more converting to WAV files unless you actually 
want to! The only drawback to this engine is that the ripping may be a tad slower as we go to a 
temp WAV file first, as well as we lose the ability to burn CD-text.  Also, ripping to memory 
should be included in that version.  The new CD engine comes with its own ASPI and we should 
see many of the ASPI errors go away.  Note that you can also switch to the old CD burning 
engine if you want to do CD-text.

• Adds support for Microsoft’s WMA format.  (This assumes that they are not digitally protected 
via DRM.) Will rip to WMA and will burn non-DRM WMA files.

• Adds more control to import logic.  Can select which folders it searches AND which folders to 
never search.

• Faster startup and improved the speed of import and library operations.

• Miscellaneous bug fixes.



Find Your Songs
There are many ways you can load songs into Acoustica MP3 CD Burner.  

Find them Add them Drag them in from Windows 

Rip them  Scan For Songs 

Finding your songs
Find a Specific File 
Find By Specific Directory or Folder 
Find By File Type 

Playing Your Found Songs 
Sorting Your Found Songs 
Edit Tag Info 
Locate Song In Library 
Delete a song from the Library 

If you don’t see the "Find Songs" window pictured below, click the  button 
on the toolbar.

The software will first search your Music Library for matches.  After that, it will scan 
your computer for new songs.  As it finds new songs, it will add them to your Music 
Library and if it matches the query, it will show up in the results.  Note that if you do 
not want it to scan your computer for new songs, that aren’t already in your library, 
uncheck the "Search for new songs" item.

Find a Specific File
You can search for a song by its title, artist or genre.  For example, if you are looking 
for songs by "Billy Bragg" you can type ‘bragg’ in the  "Search for" field without the 
single quotes. Then press the ‘Search’ button. 



Just click the songs you wish to add to the Song List to be burned to a CD.  Once 
selected, the checkbox will appear checked and the text will turn blue.  Or, 
alternatively, you can click the "Add Found>>" button to add all found songs to the 
Song List.

Find By Specific Directory or Folder
You may also search for songs by directory or folder name. 
For example, if you had a bunch of music files in a folder called ‘My Music’, you 
could search for those files by typing ‘My Music’ in the "Search for" field.  This is 
useful if you don’t remember the exact name of a song, but know where it is stored.

Playing Your Found Songs
You can play and preview your songs directly from the Find window.  Just click the  
button next to the song.  See more on playback …

Sorting your found songs



You can sort the songs by clicking one of the column headers.  Click the column 
header again and it will sort it in the opposite direction.

The screen shot above shows where to click to sort by that column header.

Find By File Type
You can also select what file type you would like to filter the search by.  For 
example, if you need to find WAV files, make sure to search on ".wav" or if you are 
looking for WMA files, search on ".wma".

Adding songs
If you know where you songs are, you can quickly add them directly into Acoustica 

MP3 CD Burner.  To do this,  click the "Add" button  on the toolbar or the 

Add button   on the right side.  You can also select "Add Songs" from the 
"Song List" menu.  
A standard window will pop up and allow you to navigate to your songs folder. Select 
one or many songs to load.

Drag them in from Windows
You can drag songs from a Windows folder and then drop them onto the Acoustica 
MP3 CD Burner window.



To do this, double click "My Computer" and navigate to the folder with your MP3s.  
Highlight one or many MP3s.  Click on the blue or selected area of one of the files 
and then move the mouse over the Acoustica MP3 CD Burner window.  When the 
cursor has a + underneath it, you should release the mouse and your files will be 
imported.

In addition, you can drag entire folders in!  The software will automatically create 
folders and load in all the contained songs, including songs in sub-folders.  

Edit Tag Info
You can edit a track’s tag information (track name, artist, album, genre, year or 
comment)   by right clicking the song and selecting "Edit Tag Info" from the right click 
menu.  This brings up the Edit Tag Info window. 

Locate Song In Library
You can quickly locate a song in your music library by right clicking on a song and 
clicking "Locate Song In Library" from the right click menu.  This will cause the library 
tab to be displayed and the track will be highlighted in gray.

Delete from Library
This is a useful option if you find a song, which you would not like to show up in your 
search results.  Rather than go into the library tab to delete it, you can click "Delete 
from Library" on the right click menu, to have it removed.  Note that you will still need 
to go to the Library menu and select "Empty Trash" to permanently remove it. 





Your Music Library
The Music Library will contain all the songs on your computer, which includes:

• Songs you downloaded

• Songs from CDs you ripped.

• Recordings you created

• Anything in MP3, OGG,  WMA or WAV format that is longer than 1 minute  
(1 minute is the default minimum length and can be changed in the Preferences.)

Any changes made can be undone if you make a mistake.  Simply click "Ctrl+Z" to 
undo and "Ctrl+Y" to redo any changes.

If you don’t see the "Music Library" window pictured below, click the  
button on the toolbar.

Scanning For Songs Browsing Your Library 

Retagging Your Songs Quick Retag 

Deleting Songs Playing Songs in the Music Library

Clean Library Delete Library 

Scanning For Songs
The software will automatically look for new songs on your computer.  If you have 
downloaded or copied new songs to your computer, you’ll need to scan them into 
Acoustica MP3 CD Burner.

Click the "Scan" button to start scanning for eligible songs.  By default, it will look for 
MP3, WMA, OGG & WAV files over 1 minute in length.  You can change where and 
what it scans by changing the "Sound Scan" Preferences. 

Browsing Your Library
You can browse your library in 2 ways:

• By Artist and album



(Sting, Alanis, Bach, Toad, Miles Davis, etc.)

• By Genre (or style)
(Jazz, Blues, Rock, Classical, etc.)

To browse by artist, click the + sign by the "Browse by Artist" item.  It will expand and 
show you all of your artists.  Then click the + near an artist you’d like to expand and 
it will show you all albums and songs under that artist.  

The above shows the Music library in action.  In this case we have selected 4 songs 
under "Alicia Keys".

Retagging Your Songs 
In a perfect world, we wouldn’t have to do retag our music, but in many cases the 
songs that you download or rip aren’t titled or tagged correctly.

Simply right click on a song to correct any erroneous information and the following 
dialog box will appear.



You can edit the song information for individual songs this way.
• Title  (The name of the song)

• Artists (self explanatory)

• Album (self explanatory)

• Year  (The year the CD was made.)

• Track (original track number on the album)

• Genre (The style of music)

• Comment (Whatever you’d like)

In addition to editing a single song, you can correct albums and artists by right 
clicking on them and editing their information.

Quick Retag
One of the neatest tricks in quickly retagging or fixing your music library is by drag 
and drop. 



In this example, I have 2 albums related to Sting .  One is lower case and one is 
upper case.  I simply click on ‘sting’ and drag it onto ‘Sting’ with the capital S, and 
viola, the small case ‘sting’ and all of it’s songs and folders are automatically 
retagged to be correct. 

You can also do this with individual songs or albums or for reorganizing by genre.

Deleting Songs
You can use the Music Library to clean up songs that you don’t want.  Simply right 
click on an artist, album or song and click "Delete".  Alternatively, you can drag and 
drop artists, albums or songs onto the trash icon.

If you accidentally delete a song, simply click "Ctrl+Z" for undo.  (Alternatively, you 
can select "Undo" from the "Edit" menu.)

Deleting these songs do not delete them permanently from your hard drive.  They 
are simply in the MP3 CD Burner ‘trash’.  To permanently remove these songs, 
albums and artists, click "Empty Trash" on the Trash icon or by clicking "Empty 
Trash" from the "Library" menu.

What happens when you click "Empty Trash"?  There are 3 options.

• The first choice will actually move the songs into the Window’s "Recycle Bin". 
** BE WARNED AND BE CAREFUL – Some of the sounds could be 
important to some programs and games on your computer and could 
cause them not to run properly.  Make sure that these songs are ok to 
delete!  Acoustica cannot be held responsible for any lost sound files 
that are deleted this way.**  The final step is to go right click on your Window
’s Recycle Bin and select "Empty Recycle Bin"

• The second choice removes the song(s) from your library, but does not 
remove the songs from your computer.  After removing it, it brings up the 
Preferences "Sound Scan" screen which allows you to add a directory to the 
"Exclude List" so that the song is not re-scanned.  Why would you do this?  If 
the sound scan is picking up songs from a game for example, you can add 
the game directory to the "Exclude List".  IE: If you had a ton of songs from a 
game located at C:\Program Files\Star Wars\ then you could simply add this 



directory and they won’t be picked up again in the next scan!

• The third choice simply removes the song from the library.  The next time a 
sound scan occurs, it will re-import the song!

Playing Songs In Your Library
Once you’ve amassed a collection of songs, it’s nice to be able to play them!  
Simply click the  play icon to start a song playing.  

Playback modes

• Continuous play – will automatically advance to the next song.

• Random play – If continuous play is on, the next song will be a totally random 
selection from anywhere in your library.

I like to play in continuous and random play to keep things fresh when I’m working 
along. �  For more on playback, click here. 

Cleaning The Library
Get out the broom and dustpan! � Not.  This process simply removes any songs 
that can no longer be found on your computer.  (They’ve either moved or were on a 
temporary device like network drive, CD drive, etc.)  To clean your music library, 
select "Clean Library" from the "Library" menu.

Deleting The Library
If you’ve imported a bunch of songs that are of the wrong length, or wrong directory, 
it’s sometimes easier to just start over and delete the library.  Select "Delete Library" 
from the "Library" menu.  (Note that this will cause the software to restart, so you’ll 
need to save any work.)
 



Rip Your CDs
Ripping is the process in which you can copy audio track(s) from your personal CDs.

You can rip an individual song or all the tracks from a CD.  To rip a CD, click on the 
"Rip CD" toolbar button or click a CD tab.  ( These tabs are above the playback 
controls and would be called CD Drive D or CD Drive E, depending on your computer
’s setup.) 

After you have the CD ripping window up, you should put in a music CD to rip.  

NOTE: Another program may pop up and try to play it or record it, but you should 
click it away.

There are several phases to ripping a CD:

1. Identify Your CD Automatically! (Or Manually) 
2. Select Your Songs To Rip 
3. Rip Your Songs 
4. Speed Rip 

(The above shows the CD Ripping area with 9 unidentified tracks.)
If you are having problems ripping, see the troubleshooting area.



Identify Your CD

MP3 CD Burner will automatically attempt to locate your CD through the Internet!  
The software will attempt to connect with a "FreeDB" server to get the information.  

Note that you may want to switch to a closer freedb server via the Preferences.

Make sure that you are connected to the Internet before this process starts.  (It will 
attempt to connect to the freedb 3 times.)  There are a few different outcomes 
depending on the situation.

1. Your CD is identified without any problems.  (The best)
2. Your CD is identified, but there are several possible matches. 

(In this case, select the appropriate album and then click OK)

3. Your CD is identified, but there is some missing information such as the year of 
the CD or the genre of the CD.

(If this is the case, it will ask you if you’d like to fill in the missing info.)

4. A match could not be found and you have to enter in the information by hand!  
Even this process is relatively easy!



 

To enter in the CD information by hand, right click on a CD track and select "Edit 
Tag Information".  The interface is set up so that you can enter in the artist, 
album, year and genre once and then simply type in each track name without 
leaving the window.

a. Click on the Artist area and type in the artist’s name.
b. Press tab to get to the Album field or click Album and enter the album 

name.
c. Repeat this process for Year and Genre.
d. Then click the Title edit box and enter the title for the track
e. To get to the next track, simply click "Next >>" or Press the ALT button 

and the ‘N’ key
f. Continue until all tracks have been named and then Click the Save button!

The "Look Up" button can be used to try to identify the CD later in case the Internet 
was not active or the freedb server was busy, etc.

In some cases, the artist, album or track information that comes back will be partially 
wrong or totally wrong.  If this is the case, you should manually edit it to be correct. 



Select Your Songs To Rip
This is as simple as clicking the song so that it is "checked"

By default, MP3 CD Burner selects all songs to rip.  

If you only wish to rip 1 or 2 tracks, simply right click on CD track list and select 
"Deselect All Tracks".  Then click the tracks that you’d like to rip.

If you have already ripped a track and wish to rip it again, you can click "Mark all 
tracks as ‘un-ripped’" which will allow you to re-rip the track.

Rip Your Songs
This is as simple as clicking the "Rip Tracks" button on the window (or Ctrl+R).  Your 
songs will be ripped in the MP3 format by default.  To change the format, you should 
go into the Preferences.  (MP3, OGG, WMA and WAV can be selected.)  If the "Add 
ripped songs to Song List" is checked, the song will be copied to the Song List once it 
is completed.

Freshly ripped songs will automatically be added to your library.  The following image 
shows a rip in progress.

An orange color represents that a track has been ripped.

Problems can crop up when ripping!  In some cases, you may have pops or artifacts 
in the ripped track and in other cases; it may not be able to rip a track.  Here are 
some things to try.

• Clean the CD, especially if it is dusty or has spilt milk on it. ;-)

• If you have 2 CD drives, try ripping it in the other CD drive.  (Some drives are 
more tolerant of errors than others.)

• If there is a lot of popping, run an anti-pop or click removal software program.  
(It may not help all cases, though.)

• Shut down other programs, including screensavers and virus checkers to free 
up your computer’s resources.

• Try ripping to WAV format, instead of MP3 or WMA.  (This requires less 



computer power.)

• Change your ASPI layer.  (If you are not using the Gear engine and are using 
the Goldenhawk engine.)  If you are using Acoustica, try un-checking it to use 
the default Window’s ASPI layer.

• Try changing some of the ripping preferences in the Preferences.
o Changing Jitter from ‘Auto’ to "ON" may help.  (It will also go slower)
o Lowering the rip speed may help with errors
o Changing the error correction to retry more times may help as well.

Speed Rip
If you are interested in ripping CDs as fast as possible and size is not an issue, you 
should choose this option.  IE: You have lots of available hard drive space, you 
should choose to rip to WAV files.  Note that you will use up about 10 MB per minute 
of audio.

Go into the Preferences by clicking Preferences from the File menu.  Click the 
"Ripping Tracks" item and then click "Temporary WAV files only" or change the 
setting in "Store in format" to WAV.



Play Your Songs
The playback controls are shown below.

 Use this button to rewind the current song and start playback from the 
beginning.  If less than 4 seconds have played, it will start playback of the previous 
song.

 Use this button to start playback of the next song.  (Find or Arrange window.)

 /  Use these buttons to start and stop playback. 

  You can use the slider to restart the playback from a given offset.

Playback Modes
There 2 modes when playing back songs.

Continuous – This mode will play songs indefinitely.  If it reaches the end of a song 
list, it will start over from the beginning.

Random – If in continuous mode, this will cause a totally random song to play next.

The song that the software will choose to play next will be from the last window that 
they clicked the  button on.  For example, if you click the  button on the Music 
Library window, then the subsequent songs will be picked from the Music Library.   
Note that if there is only 1 song in the active window, such as the Find or Song List 
window, then that song will play continuously.  (You never know, someone out there 
may have intended that. � )

Songs can be set up to fade from one to another, as well.  For more info on this set 
the Fader to "Mix Tracks". 



  



Arrange Your Songs
Once you have found your songs, you can rearrange their order in a few different 
ways.   You also have the choice of making either an audio CD or a MP3 CD.

Audio or MP3 CD? 

Moving Songs 
Shuffle 
Sorting 
Deleting Songs 
Adding Songs 
Playing Songs

Undo & Redo   
Copy & Paste 
Copy Track Information 

Setting Song Volume/Boost/EQ 
Trimming/Fading/Mixing Songs 

Open Containing Folder 
Edit Tag Info 
Locate Song in Library 
Delete a Song from the Music Library 

This screen shot shows the "Song List" interface.



Audio or MP3 CD?
The main new addition to the Song List, is that now you have a choice of the type 
and size of CD you’d like to create!  This is an important choice, as you need to 
make sure that it will play on your CD player.  To choose the type of CD, click either 
the "Audio CD" or "MP3 CD" radio button.

Audio CD
This is the type of CD that plays in 100% of all CD players.  This is the kind of CD 
that you buy at the music store.  You are limited to 21, 74 or 80 minutes of audio.  
(Note that you can’t have more than 100 different tracks, which is a limit of the audio 
CD spec.)  If you leave it on "Auto", put in a blank CDR before starting a burn and it 
will automatically detect how much room you have.)



MP3 CD/DVD
The MP3 CD stores actual MP3, or WMA files just as if they were on a hard drive.  It 
is not readable by normal CD players.  However, if you have an MP3 CD player, you 
will be able to play up to 200 songs on a single CD!  

The number of songs that you can fit on a MP3 CD depends on how big the songs 
are in terms of MB, instead of length in time.

The above shows the how the "Song List" looks when you choose "MP3 CD".  The 
top window shows your folders and the bottom window shows the contents of the 



currently selected folder.    

You can do the following things in "MP3 CD" mode.

• Create and rename folders

• Move folders by dragging them to new parent folders.

• Move songs from one folder to another by selecting them and then dragging 
them to a new folder above.

• Select from 185 MB, 650 MB, 700 MB CDs, or 4.7 GB DVD project sizes. 

The first time you select "MP3 CD" mode, you will start the MP3 CD wizard which 
lets you choose the best settings for your MP3 CD, including bit rates & audio 
formats that your player supports, file order preservation and folder options.  You 
can also change these settings in the "MP3 CD" section under the Preferences.
See MP3 CD Wizard 

Moving Songs
To move a song, click on it and then drag it to the new position.  You will see a blue 
underline, which shows where the song will move once the mouse is released.

Alternatively, you may use the up arrow  or down arrow  to move the 
selected song(s) up or down.

In "MP3 CD" mode, you can also drag songs above into a different folder.

Shuffle
Shuffle is a quick way to arrange your tracks into a new random order.  To shuffle 
your tracks, select "Shuffle" from the "Song List" menu.  



Cross Fader
You can fade songs when in "Audio CD" mode.  When in "Audio CD" mode, click the 

"X-Fader" button  launch the Cross Fader dialog .  The cross fader is a 
quick way to get fades and overlaps set for all songs in the "Song List".  After that, 
you can fine-tune your fades and mixing via the "Trims, Overlaps & Fades" window. 

Sorting
You can sort by each column header by clicking on it. Here are the columns you can 
sort by.

Title – The title track of the song.
Length – The length of the track.
Status – Ready, Preparing, Converting, Burning, Burned, Missing, etc.
Album  - The album for the track.
Artist – The artist.
Genre- The style or genre of the track.
Type – The file type (WAV, WMA or MP3).
Format – The bit-rate or sample rate of the track.
Size – The size in bytes, KB or MB of the track.
Track # - The CD track # that corresponds with the original CD track, usually.
Location – The folder and filename.

Deleting Songs
You can delete a song by clicking the song followed by selecting "Delete" or "Cut" 
from the "Edit" menu [Ctrl+X].  



Alternatively, you can also press the Del button  or press the [Delete] key to 
delete a track.

To delete all the songs in your list, select "Remove All Songs" from the "Song List" 
menu.  

Undo & Redo
Make a mistake?  You spent all day looking for a specific song and you just deleted 
it!  No problem!  Select "Undo" from the "Edit" menu and your song will re-appear.  
[Ctrl+Z]

You can then re-do what you just ‘undid’ by selecting "Redo" from the "Edit" menu.  
[Ctrl+Y]

Copy & Paste
If you want to have more than one instance of a particular track, select the track and 
then select "Copy" from the "Edit" menu [Ctrl+C].  To paste a copy, select "Paste" 
from the "Edit" menu.  [Ctrl+V].

When you paste to an external program, such as a CD label creation package, it will 
paste the textual track information such as track name, artist and length.  

Setting Song Volume/Boost/EQ
This allows you to change the overall strength, volume and tone of a song.  It will be 

burned to CD as you hear it.  Click the "Audio FX" button   or right click on a 
song and select "Adjust Track Volume/Boost/EQ"  This brings up the 
Volume/Boost/EQ dialog.  



NOTE: Use this option sparingly as you may introduce distortion.  If all your songs 
sound low in volume, you should simply turn up your speakers or adjust your 
Window's volume mixer.

Trimming/Fading/Mixing Songs
This allows you to do some limited editing with your songs.  You can trim them to get 
rid of unwanted applause or long silence intros.  You can fade songs and overlap 

them with adjoining songs for seamless mixes.  Click the "Mixing" button  or 
right click on a song and select "Overlaps, Trims & Fades".  This brings up the 
Overlaps, Trims and Fade dialog. 

NOTE: If you are creating an MP3 CD, the software will ignore the overlap setting 
and only burn the trims and fades.  (MP3 CD Players do not support continuous play 
without pauses.)

Open Containing Folder
This is convenient if you want to open the folder in Windows where the song is 
stored.  You might use this if there is a song in your library which you wish to delete 
or rename.

Right click on a track and then select "Open Containing Folder" from the pop up 
menu.  

Alternatively, you can select "Open Containing Folder" from the "Song List" menu 
when the track is selected.

Playing Specific Songs From the Arrange Window
Each track has a playback button  that will start playback for that track.



The above screen shot shows where the playback button is.

Click here for more on playing songs. 

Copy Track Information
Each track has associated track information such as the track number, the track 
name, the artist and the track length.   You can copy this text into the clipboard in 
order to use it in other programs such as CD label makers.

To copy the track information of a specific track, click the track to select it.  Then 
select "Copy" from the "Edit" menu [Ctrl+C].  Now go to your favorite program and 
paste it in by selecting "Paste" from the "Edit" menu [Ctrl+V].  

You may also select multiple tracks by holding down the Shift or Control key and 
clicking the desired tracks.  Once you have made your selections, click "Copy" from 
the "Edit" menu to copy them.

To copy all track information, just select "Copy Track Information To Clipboard" from 
the "Edit" menu.

Edit Tag Info
You can edit a track’s tag information (track name, artist, album, genre, original 
track, year and comment)  by right clicking the song and selecting "Edit Tag Info" 
from the right click menu.  This brings up the Edit Tag Info window. 

Locate Song In Library



You can quickly locate a song in your music library by right clicking on a song and 
clicking "Locate Song In Library" from the right click menu.  This will cause the library 
tab to be displayed and the track will be highlighted in gray.

Delete from Library
This is a useful option if you find a song in your song list, which you accidentally 
imported from a search or the library tab.  Rather than go into the library tab to 
delete it, you can click "Delete from Library" on the right click menu, to have it 
removed.  Note that you will still need to go to the Library menu and select "Empty 
Trash" to permanently remove it. 



Trimming, Fading and Mixing Your Songs
One of the features that sets Acoustica MP3 CD Burner apart from the competition 
is the ability to edit the mix on a very detailed level. 

Bring up this window by right clicking on a song and selecting "Overlaps, Trims & 

Fades" or by clicking the  button.

 The image below shows the ‘Overlaps, Trims & Fades" dialog.

Trimming Your Songs
If you have an extra long applause or unnecessary silence, you can trim or edit it out 
by simply clicking and changing the "Trim Start" or "Trim End".   To hear the trim, click 
either "Preview In" or "Preview Out".  (Note that if you have the option to 
"Automatically Remove Silence" turned on, some songs may already be trimmed.)

Fading Your Songs
If you have an extra long applause or an incomplete song, you can make it sound 
very smooth by simply adding a fade.  You can set the "Fade In" and "Fade Out". To 
hear the fades, click either  "Preview In" or "Preview Out".

Overlapping Your Songs
By changing the "Overlap" setting, you can mix the current and subsequent song.  
Usually, this works well in combination with fading.  To hear the overlapped area, 
click "Preview Mix".  Note that it will start a few seconds earlier than the overlap area.



Automatic Overlapping And Fading

If you want all songs to automatically mix and fade, click the  on the toolbar 
and select "Mix Tracks".  Choose an overlap and fade.  All songs will be automatically 
faded and mixed with these changes.  Any new songs added to the Song List will 
have these settings, as well.

Navigating Your Songs
When you are adjusting the mix, it is very handy to go back and forth from track #1 to 
track #2, etc.  Click the "Previous" and the "Next" buttons to navigate between tracks.  
(For example, when working on a fade between 2 tracks, you will also need to adjust 
the fade in of the second track.)

MP3 CD Note: When making an MP3 CD, if you want to hear trims and fades, you 
must make sure to choose "Specify Settings" and then click the option "Use trim, 
volume, EQ, Boost, fading & normalization settings".  Also, be warned that this will 
cause the "Convert" stage to take a long time, as it will have to re-render into new 
MP3 files.  (Overlapping and mixing will not be preserved in MP3 CD mode!)



Setting Volume, Boost & EQ
You can adjust the volume, boost and EQ of a song.  (These settings are applied 
when burning CDs!)

Bring up this window by right clicking on a song and selecting "Adjust Track 

Volume/Boost/EQ" or by clicking the  button.

Volume
If a song isn’t loud enough, adjust the volume to bring it up or down.  Click "Reset" to 
return it back to 100%.

Boost
Boost will increase the "loudness" of a song by squashing the higher volume parts 
and bringing up the lower volume parts.  Click "Use Boost" to turn on boost for the 
current song.  (The effect approaches the sound of the booming voice of a radio DJ 
on the extreme side.  For those that know more about audio technology, Boost is 
really dynamic compression.)

� Level
The Boost Level specifies the threshold to start boosting songs.  The higher it 
is, the more it will boost.  Be careful, adjusting this setting, as you may 
introduce distortion, especially if you set it above 65%.

� Power 
This is the ratio that the song is boosted.  For example, if a portion of a song is 
found to be below the "Level", it is then adjusted by the "Power" setting. 

� Reset
This returns the boost settings to the default settings.  (Of course, turning off 
boost will make sure to not alter the original audio.)

Equalization
By turning on EQ, you’ll be able to adjust 10 frequency bands that will affect the 
tone of the song.  This is similar to adjusting the graphic equalizer on a stereo 
system amplifier.  You may also choose a preset such as "Boost Bass", "Boost 
Treble", etc.

NOTE: We recommend that you use this sparingly.  Don’t try adjusting the song to 
your specific computer speakers.  The speakers that you play your CD on may 
sound totally different!



MP3 CD Note: When making an MP3 CD, if you want to hear these changes, you 
must make sure to choose "Specify Settings" and then click the option "Use trim, 
volume, EQ, Boost, fading & normalization settings".  Also, be warned that this will 
cause the "Convert" stage to take a long time, as it will have to re-render into new 
MP3 files.



Burn A CD!
You’ve got your songs arranged the way you want.  You are ready to create your 
custom CD!  Note that you will have to have a supported CD recorder in order to 
burn a CD or DVD.

Note: Did you want to burn an MP3 CD or an Audio CD?  You can select this and 
the media size on the Song List screen.  More …

Specifying the Silence Between the Tracks 
Blend or Mix Adjacent Tracks Radio DJ style! 
Selecting Too Much Audio 
Burn Options 
Burn Process 

Specifying the Silence Between The Tracks
**This only applies to "Audio CD" mode.**  Before you burn, you can fine-tune how 
you want your CD to sound.  You can set it up to have several seconds of silence or 
no silence between tracks.  If you are feeling fancy you can even have it mix 
between tracks just as they do on the radio.

To set the amount of silence or no silence between tracks, select "Fader Settings" 

from the "Song List" menu or click the "Cross Fader" button  .  This brings up 
the "Fader Settings" as shown below.



Select the setting you would like and then click "OK".

Blend or Mix Adjacent Tracks Radio DJ Style!
**This only applies to "Audio CD" mode.**  You can create a CD where the tracks 
mix into each other.  Click "Cross Fader Settings" from the "Song List" menu or click 
the "Fader" button on the toolbar.



Click the "Mix tracks" radio button.   You can set the overlap and fade time.  Overlap 
time specifies the amount of time that songs overlap each other.
                                        [overlap]
[ Song A ------------------------------]
                                        [-------------------------------Song B]

The overlap length sets how long the songs cut overlap each other. 

The fade time specifies how long it takes to transition to the next song.  Generally, 
shorter fades work better, especially with songs with heavy rhythm. 

Selecting Too Much Audio



After clicking "Burn CD!" from the "Song List" menu 

or clicking the "Burn CD"  button on the toolbar, 
you may see a window titled "Selected Audio Will Not Fit!"  

If you have more than maximum minutes of audio selected, you can do one of three 
things.

1. Fade out the extra audio.  Choose the length of the fade.  The default is 2 
seconds.

2. Cut off the extra audio.  It may not sound graceful…but the option is available.
3. Cancel the dialog and remove some tracks and then try to burn again.

Burn Options
After clicking the Burn button, the "Burn Audio CD!" window comes up with several 
options that you can set.   To start burning, click the "Start" button.



Burner Speed 
Number of Copies 
Convert All Tracks To WAV Files First

Test Burn Mode 
Test And Then Burn Mode 
Burn CD Mode 



CD Burner Options 

Convert all tracks to WAV files first.
**This only applies to "Audio CD" mode.**  This option will ensure that all 
tracks are first converted to WAV files before being written to the CD.  You 
are required to check this option if you are mixing between tracks.  

Burner Speed
This defaults to "Max" which is the maximum speed possible on your CD 
recorder.  1X speed recording is comparable to the amount of time 
necessary to playback an audio CD. Since an audio CD holds 74 minutes, it 
will take 74 minutes to record an entire CD at 1X speed.  An 8X speed 
recorder will take 74/8 minutes, which is about 9 minutes.  If you are lucky 
enough to have a 16X speed burner, it will take about 4.5 minutes to record 
an entire CD!

If you are having problems recording a CD or if you wish to do other things 
during a burn, such as browsing the web, you should choose a lower burn 
speed.

Make (Number Of Copies)
If you are making more than one copy, change this control to the number of 
copies you wish to make.  You will be prompted to insert the blank audio CDs 
when needed

CD Burner Mode



Test burn. A test burn will simulate an actual burn without using a blank 
CD-R. You will be required to put a CD-R in, but it will not use the burn laser 
on the CD-R. It is mainly a test to see if the data can be delivered to the CD 
recorder quickly enough to avoid ‘data starvation’ or the famous ‘buffer 
under run’ error.

Test and then burn if successful test.  This will perform a test and then if 
the test goes smoothly, it will start the burn without any user interaction.

Burn CD!  This will go straight to burning an audio CD.  (No tests will be 
performed in this mode.)

Burn Process
The burn process involves a few steps. The screen shot below shows the burn/test 
progress window.



The burn process consists of several stages.

1. All audio files must be "Prepared".  Acoustica MP3 CD Burner analyzes all songs 
to determine the exact length.

2. Some or all tracks will be converted to WAV files first.  The tracks may be 
converted if they need to be normalized or auto-trim settings or trimmed.  See 
the Preferences to set these parameters.

3. Burn or test begins.
4. Each track is burnt or test-burnt.
5. Burn or test finalizes.

You can abort at any time by clicking on the "Abort" button.  If burning, aborting after 
stage 3 will result in an unusable CD.  (Acoustica MP3 CD Burner will ask you if you 
are sure you want to abort, though.)





Toolbar Help

New  Creates a fresh, new session.  Any songs in the Song List window are 
removed.

Open   Brings up a window allowing you to open a previous burn session (.cbs 
file)

Save   Saves the current burn session.  If you haven’t saved it yet, Acoustica 
MP3 CD Burner will ask you for a name and location to store it to.

Burn CD  Will bring up the "Burn Audio CD!"  window. 

CD Label Will launch Acoustica CD Label Maker, if it is installed.  To install 
Acoustica CD Label Maker, visit http://www.acoustica.com 

Find   Will toggle showing the Find window on and off.

Library Will toggle showing the Music Library window on and off.

Rip CD Will toggle showing the CD ripping windows on and off. 

Add Let’s you add songs from a folder

X-Fader Brings up Cross Fader dialog

BUY Click this button to purchase the software!  Follow the instructions 
detailed here. 



File Menu
New Song List

Creates a new song list with a new title.

Short Cut: Ctrl + N

Open Song List…

Opens an existing song list  made previously with Acoustica MP3 CD Burner

Short Cut: Ctrl + O

Save Song List

Saves the current Song List.  If nothing was saved before, it will prompt you for a file name.

Short Cut: Ctrl + S

Save Song List As… 

Saves the song list in a specified location. 

Preferences…

Opens the Preference window. 

Recent Acoustica MP3 CD Burner Sessions

This is not an actual menu item.  However, the 8 most recently used Acoustica MP3 CD Burner session will appear under 
the File menu.  Just click one of this previous Acoustica MP3 CD Burner sessions and it will load into the session.

Exit

This quits the program.



Edit Menu
Undo

Use this if you made a mistake or want to go back to a previous state.  Undoable actions include adding tracks, deleting 
tracks, moving tracks, sorting tracks, shuffling tracks, renaming tracks, and re-setting a track’s volume. More. 

Short Cut: Ctrl + Z

Redo 

Use this if you want to go back to a state before an undo.  Undoable actions include adding tracks, deleting tracks, 
moving tracks, sorting tracks, shuffling tracks, renaming tracks, and re-setting a track’s volume.  More …

Short Cut: Ctrl + Y

Cut 

This will remove the selected track or tracks from the Arrange window. The track or tracks will also be placed on the 
clipboard for pasting if desired.  Relevant textual track information is also copied to the clipboard. 

Short Cut: Ctrl + X

Copy 

This will copy the selected track or tracks from the Arrange window. The track or tracks will also be placed on the 
clipboard for pasting.  Relevant textual track information is also copied to the clipboard. 

Short Cut: Ctrl + C

Paste

This will paste any tracks in the clipboard into the Arrange window. 

Short Cut: Ctrl + V

Delete 

This will remove any selected tracks from the Arrange window 

Short Cut: Delete key

Select All 

This will select all tracks in the Arrange window 

Short Cut: Ctrl + A

Copy Track Information To Clipboard 

This will copy all textual track information to the clipboard.  This can be pasted into other programs such as a CD labeling 
software package. 

Show Toolbar 

This lets you toggle the toolbar from being visible to not being visible, and vice versa.



Find Menu
Show/Hide Find Tab

This lets you toggle the Find Songs tab from being visible to not being visible, and vice versa.

Start Search

This will begin a search.  It will search on the text in the "Search for" field on the Find Songs tab.

Add All Found Songs To Song List

Adds all found songs currently in the Find tab to the Song List window.

Short Cut: Ctrl + I



CD Menu
Show CD Drive

This lets you toggle the CD Drive tab(s) being visible to not being visible, and vice versa.  A sub menu will pop up with a 
list of your CD drives so that you can select the desired CD Drive.  See CD ripping for more …

Play/Stop Track

This will play the currently selected CD track.  Note that if you don’t hear the music, you may need to adjust your Window’
s mixer settings.

Rip Tracks

This will start ripping the currently selected tracks from the current CD Drive.

Short Cut: Ctrl + R

Select/Deselect This Track

This will select or deselect the current track.  ( A selected track will have a check in it’s checkbox and will be ripped when 
"Rip Tracks" is pressed.)

Deselect All Tracks / Select All Tracks To Be Ripped

This will select or deselect all tracks.  ( A selected track will have a check in it’s checkbox and will be ripped when "Rip 
Tracks" is pressed.)

Edit Tag Information

This will edit the CD tag information for the currently selected track.  See more on this …

Mark All as Uncopied

This will allow you to re-rip any tracks that you’ve already ripped.   This is useful if you’ve ripped the songs in the wrong 
format, etc. 

Look Up Album Info

This will look up the song track information for the currently selected CD drive.

Erase CDRW…

If a CDRW is in the CD/DVD writer, this will do a quick erase on the CDRW .  (This may take up 2 minutes)



Song List Menu
Cross Fader Settings… 

This brings up the Cross Fader window. 

Shuffle 

This will re-arrange your tracks in a random order.

Add Songs…

This lets you import specific files from specific folders.  More …

Short Cut: Ctrl + T

Remove All Songs

This will remove all songs from the "Song List" window.  

Edit Tag Information

This will bring up the Edit Tag window on the currently selected song in the Song List  

Adjust Track Volume/Boost/EQ

This will bring up a window allowing you to change the volume, boost and EQ on the selected track.  More …

  Overlap, Trims & Fades

This will bring a window allowing you to adjust the trims, fades and mixing for the most recently selected track.  More …

Open Containing Folder

This will open the folder in Windows containing the file for the most recently selected track.  More …

Audio CD Mode

This option will be checked if the Song List is currently in Audio CD mode.  (MP3 CD Mode will be checked when this 
unchecked)  More …

MP3 CD Mode

This option will be checked if the Song List is currently in MP3 CD mode.  (Audio CD Mode will be checked when this 
unchecked)  More … 

Launch MP3 CD Wizard

This brings up the MP3 CD Wizard.  More …

Burn CD!

This will bring up the "Burn Audio CD!" window, a click away from burning your CD. 

Short Cut: Ctrl + B



Player Menu
Play / Stop

This will start playback from the previously stopped song or from the last song selected in the Arrange window.  If the last 
song selected was in the Find window, it will start playback from the Find window.  Of course, if a song is currently 
playing, it will stop playback.

Previous Song

This will play the previously played song.  (This will not work if in "Random Playback" mode though)

Next Song

This will play the next song.  (If in "Random Playback" mode, this could be any song on the list.)

Random Playback

If this is checked it will cause Acoustica MP3 CD Burner to playback songs in a random order.  Otherwise, the next song 
played will be the next one down the list.

Continuous Playback

If this is checked, when the currently playing song is finished, Acoustica MP3 CD Burner will start playing the next song.  
If this is not checked, playback will stop when the current song finishes.

Adjust Master Volumes…

This brings up the Window’s soundcard mixer control, which allows you to adjust your Wave, MIDI, CD, auxiliary and 
master volumes for your soundcards.  You should adjust this first and then raise or lower the volume of your speakers for 
best results.



Help Menu
Help With This Software

This is where you are now. �  I hope you are enjoying the software!

Go To CDBURNER.COM

This will launch your default web browser with the website cdburner.com.  You should connect to the Internet in your 
usual fashion if your browser does not connect you automatically.

Buy Now On-Line

This brings up the screen where you can purchase a registration code to unlock the software for unlimited usage.  
Depending on the method you register, a  registration code will be delivered at any time of the day or night in a matter of 
minutes!  More …

Enter Registration Code

This brings up the screen where you can enter your purchased registration code into the software.

Check For New Version…

This option will contact our website to see if there is a new version of Acoustica MP3 CD Burner available.  Upgrades are 
free for the life of the product!

Acoustica Software Products

This option will bring up a submenu with some of our other products.  (Acoustica MP3 Audio Mixer, Acoustica MP3 To 
Wave Converter PLUS, Acoustica CD Label Maker, and the Acoustica Power Pack)

About Acoustica MP3 CD Burner…

This brings up a window with copyrights, credits and contact information for Acoustica.



Preferences
The preferences are settings that aren’t changed that often. 

To access the Preferences, click "Preferences" from the "File" menu.  There are 6 
different sections.  Just click on the section you’d like as seen above.  After clicking 
the section, the right hand portion of the screen will show the details.

General 
Audio Processing 
Clipboard 
CD/DVD Burner 
MP3 CDs 
Ripping Tracks 
Sound Scan 
Remote Database 



General Preferences
Use small toolbar
Check this to save vertical screen real estate on the toolbar.  (It shrinks the toolbar.)

Create log file
A log file will be created during operation of the software so that errors or program 
defects can be tracked.  If you feel you have found a bug or are having technical 
problems, please send us your ‘cdburner-log.txt’ file located in your Acoustica MP3 
CD Burner directory.

CD Rip/Burn Engine
This option will only be visible if the Gear CD Burning engine has been installed.  
The Gear engine is a separate install.  To install it, please visit 
http://www.acoustica.com/mp3-cd-burner/support.htm. Burning and ripping CDs is a 
difficult process.  We license two technologies to burn CDs (Gear & Goldenhawk).   
For support reasons, we give you a choice of the engine.  We recommend that you 
use the Gear engine.  Note that if you want to burn CD-Text, you will need to switch 
to Goldenhawk.

Use Acoustica’s ASPI driver
**This only applies if you are using the Goldenhawk engine, as Gear has it’s own 
pre-installed ASPI drivers.**  If this option is checked, the software will attempt to use 
special ASPI drivers supplied by Acoustica’s web page.  The ASPI layer is how the 
software communicates with the CD drives.  (Note that these special ASPI drivers 
are not part of the default download.)  See 
http://www.acoustica.com/mp3-cd-burner/support.htm for more info.  

Show Song List Columns
Choose which columns to show in the Song List window. 

� Title
� Length  (In Time)
� Status
� Album
� Artist
� Genre
� Type  (MP3, OGG, etc.)
� Format  (Bitrate, channels, etc.)
� Size (Megabytes)



� Track # (Original Track Number)
� Location (File location)



Audio Processing Preferences
Automatically Boost Songs That Need It 
Automatically Check For Incomplete Songs 
Normalize Track Volumes 
Automatically Remove Silence 
Advanced 

Automatically Boost Songs That Need It 
When you add a song to the Song List, the software will parse it and analyze it to 
see if it needs a boost.  Basically, if the song’s relative ‘loudness’ is too low, it will 
apply some boost automatically.  This saves you from potentially embarrassing and 
frustrating experiences of burning a song and having to constantly adjust the volume 
dial!  

Boost Setting
Choose from Light, Medium and Strong.  Light boost may not be overtly 
audible, whereas Strong boost might cause a mild amount of distortion.

Warn Me When A Song Is Automatically Boosted
When the software is done parsing a song, this will pop up a dialog to warn 
you that it has been boosted. The song will also show the boost symbol next to 
it: 

Automatically Check For Incomplete Songs 
The software will scan the song to determine if it is incomplete or cut-off too early. 
This can happen due to partial downloads, partial rips, etc.  When a song is 
determined to be incomplete, you will see the  symbol next to it.

The algorithm works by testing the volume level for the last 20 milliseconds of the 
song.  If it is beyond a threshold value, it will notify you that it may be a possible 
incomplete song.  The threshold value can be set from 0% (absolute silence) to 
100% (half max volume)  The default setting is 12%

For those downloading their music, this is a useful option to help avoid burning 
partial songs!

Warn About Incomplete Songs



When the software is done parsing a song and it is incomplete, the software 
will pop up a dialog to warn you that it might be incomplete.  You will have the 
option of playing the very end of the sound.

Fade Out Incomplete Songs
If a song is determined to be incomplete, it will automatically fade it out so that 
it sounds less abrupt.  (A very nice feature for songs that are 90% there, etc.)  
You can specify how long the fade should be.

Normalize Track Volumes
What is normalization?  It is a technique to take a low-volume recording and boost its 
volume so that it matches other volumes.  

Acoustica MP3 CD Burner will normalize a track if its volume is different by the 
specified percentage.  Enter a percentage cut-off level that will cause sounds to be 
normalized.

You can also choose what source Acoustica MP3 CD Burner will use to measure the 
volume level.  It can measure against the loudest track or the loudest volume 
possible.

Low volume songs are ‘normalized’ to sound consistent with other tracks.  

Automatically Remove Silence
What is auto-trim silence?  It is a technique to remove silence at the beginning and 
end of a song.  If you want to make sure that you don’t have silence between tracks, 
set this to a low number.

If the silence is not automatically trimmed, you can always select the sound and then 
click "Overlaps, Trims & Fades" to adjust the trim.

Advanced



Set the # of playback buffers and buffer size.  If you are experience gaps are static 
when using the software to listen to songs, try increasing the buffer size.  If you’d 
like the wave form display to be more responsive when playing back sounds, lower 
the buffer size.



Clipboard Preferences
These options control the text that is copied into the clipboard when you copy a track 
in the Song List.

Copy track # - the track’s number or order on the CD is copied into the clipboard

Copy track length – the track’s length in time is copied into the clipboard

Copy track title – the track’s title is copied into the clipboard.  Also see renaming 
tracks.

Copy artist – the track’s artist field is copied into the clipboard

How to copy track information 

Acoustica CD/DVD Label Maker
If you’re looking for an industrial strength CD/DVD label maker that makes CD 
labeling fun & easy, try out Acoustica CD/DVD Label Maker.  It integrates seamlessly 
with Acoustica MP3 CD Burner and includes over 1000 custom art CD & DVD 
labels!  Try out Acoustica CD/DVD Label Maker! 



CD/DVD Burner Preferences
Click on a topic for more help. 
CD Writer Device Eject disc when recording is done 
Play sound when finished CD-Text 
Burn-Proof 

Advanced
Auto insert notification Disconnect 
Sync Data Transfer  

CD Writer Device
If you have more than one CD recorder, this control allows you to select between 
them.  It also shows the recorder name, model and firmware version.

Eject disc when recording is done.
This option instructs the CD recorder hardware to eject the disc when recording is 
finished.  Due to varying support, this may not work on all CD recorders. 

Play sound when CD is finished.
Check this if you want to hear a sound play when a burn succeeds or fails.  The 
sounds are stored in the Acoustica MP3 CD Burner directory.  You can replace 
these sounds with your own sounds.  The success sound is called "success.wav" 
and the burn fail sound is called "failure.wav"

Use CD-Text (If supported)
Some CD players will show track and title information during playback.  Note that not 
all CD/DVD recorders support CD-Text.  Look for the CD-TEXT logo on your CD 
player to see if its supports CD-Text. (Usually, the Sony brand CD players show 
CD-text.  This will be enabled if the current CD Writer device supports CD-Text 
technology)

Use Burn-Proof (If supported)
Burn proof technology ensures successful burns.  It is highly recommended to leave 
this option checked!  (Incidentally, I’m not sure why you would turn off Burn-Proof, 
except for troubleshooting perhaps.)  Burn-Proof is also known as Just-Link.  (This 
will be enabled if the current CD Writer Device supports Burn-Proof technology)

ADVANCED



Auto insert notification
This reflects your CD-recorders auto insert notification setting.  Auto insert 
notification is how your computer automatically starts playing audio CDs you 
put in the drive.  Unfortunately, this is also what causes burn failures, 
especially during the first 5% of the burn.
Disabling or enabling auto insert notification will require a reboot to take affect. 
** Packet writing programs such as DirectCD by Adaptec require that auto insert notification is 
on. 

Disconnect
Disconnect should be turned off for SCSI CD-recorders, as they run more 
efficiently this way.
Disabling or enabling auto Disconnect will require a reboot to take affect.
*** This feature is disabled for Windows 2000 and must be enabled/disabled manually. 

Sync Data Transfer 
Sync Data Transfer should be turned off for SCSI CD-recorders, as they run 
more efficiently this way.
Disabling or enabling auto Sync Data Transfer will require a reboot to take 
affect.
*** This feature is disabled for Windows 2000 and must be enabled/disabled manually.



MP3 CDs Preferences
This preference page allows you to quickly set up rules that specify how your MP3 
CDs will be created.  You might choose to run the wizard instead. 
You can set the following MP3 CD burn modes:

STANDARD
This will attempt to burn the most compatible MP3 CD.

• Play List order is preserved!  Songs will be renamed to "01-My Song", 
"02-Blues Traveler", "03-Rocking Out", etc.  (This ensures that the 
alphabetical order will be the same as the Play List order.)

• Converts WAVs, OGGs and WMAs into MP3.  (Most MP3 CD players support 
MP3, and some support the other formats.  In this way, the potentially 
unsupported files are converted to the most common format.)

• Trimming, Fading, EQ, Normalization, Volume and Boost settings are 
IGNORED. 

FAST (Default)
This is the fastest option.  Songs get burned "as is".  

• Play List order is not preserved.  Songs will play alphabetically on MP3 CD 
players.

• Trimming, Fading, EQ, Normalization, Volume and Boost settings are 
IGNORED.

• Fastest option

SPECIFY
This option allows you to specify the exact settings for your MP3 CDs.

• Supported formats. MP3? WMA?  If your MP3 CD player supports MP3, click 
the box next to MP3.  Click the "Settings" next to the checkbox to set the min 
and max bit-rate and whether or not it supports VBR, etc.  

• Convert unsupported formats to?  Set this option to the destination format for 
any files that that need to be converted.  ** Note that you can specify the 
destination format bit rate by clicking the "Settings" button next to the format 
you’ve chosen. (Note that OGG and WAV are not destination formats, by 
design.)

• My player supports folders.  Click this if your player supports folders and then 
click "Settings" to specify further options, including how to handle sub-folders 
and the maximum # of songs and folders, possible.

• Play order preservation.  More on this …

• Maximum file name length.  (Some MP3 CD Players may not support the full 



63 characters for each file name.)



Ripping Tracks Preferences
Rip your CDs to MP3, WMA, OGG or WAV files.

Rip songs to folder 
Store songs in folder with artist's name 
Use artist in song's file name 
Use album in song's file name 
Use track number in song's file name 
Play sound when done ripping 
Rip Speed 
Jitter Correction 
Error Handling During Rips 
Rip files to (format) 

Rip songs to folder
You can specify the folder where you want your freshly ripped songs to go.  
Depending on the other options you have selected, the software may create 
sub-folders by the artist’s name.  To change the folder, click "Change" and select a 
new folder.  (Note: you may want to change your ‘rip folder’ to be on your largest 
hard drive.)

Store songs in folder with artist’s name
MP3 CD Burner will create a sub folder with artist’s name and put all ripped tracks 
within this folder.  The default location is "My Music" under your My Documents 
folder.

Use artist in song’s file name
This option will cause the software to create the ripped file to be called something 
like "Bubba Smith – My Silly Dog.mp3".  The artist is "Bubba Smith" and the track is 
"My Silly Dog"

Use album in song’s file name
This option will cause the software to create the ripped file to be called something 
like "Bubba Smith - Whole Lot Of Fish - My Silly Dog.mp3" or "Whole Lot Of Fish - 
My Silly Dog.mp3" depending on your other options.  The artist is "Bubba Smith", the 
album is "Whole Lot Of Fish" and the track is "My Silly Dog"

Use track number in song’s file name
This option will cause the software to create the ripped file to be called something 



like "Bubba Smith - Whole Lot Of Fish - 1. My Silly Dog.mp3".  The artist is "Bubba 
Smith", the album is "Whole Lot Of Fish" and the track is "My Silly Dog"

Play sound when done ripping
When the rip finishes, this option will play a sound.  This is helpful if you are out of 
the room and want to know when the rip is done!  There really isn’t much more to 
say about this one. � 

Rip Speed
This allows you to set the speed of the rip.  The default is "Max" which is the 
maximum speed possible for your CD drive.  You may choose a slower speed for 
more accurate rips.

Jitter Correction
Drinking too much coffee?  This feature will help you calm down!  �  Seriously, 
some CD drives cannot seek or move to an exact time offset on the CD and, thus, it 
is possible to have errors when copying a track.  By default, MP3 CD Burner 
automatically detects whether or not it needs jitter correction.

• If needed – This is the default.

• No  - Do not use jitter correction.  (Faster, possible inaccurate rips.)

• Yes – Use jitter correction. (Slower, more accurate rips.)

Note that jitter options are grayed out when the Gear engine is being used. (The 
default.)

Error Handling During Rips
It is possible to have a rip error if a track especially if the CD is dirty or scratched.   
By default, MP3 CD Burner will attempt to re-read the erroneous track info 10 times.  
The other options are:

• Ignore Them – Ignore errors and rip as if nothing happened. �

• Retry – This will retry reading the erroneous area for the given # of times.

• Abort – This option will halt the rip if an error occurs.

Rip files to (format)
This allows you to set the file format in which your freshly ripped files are created.



• Temporary Wave files – This option is for those that simply want to copy 
tracks for burning CDs.  These files will not be added to your Music Library.  
(The temporary WAV files are stored in your temp folder and will have the 
.tmp extension.)

• Store in format- This option is the default and will cause the ripped songs to 
be added to your Music Library.  In addition, you can choose the file format to 
rip to.

o MP3 – The default format.  (MP3s are compressed to about 10 times 
smaller than WAV files for a similar quality)

o WAV – Uncompressed audio format.  (Ripping will be much faster 
because there is no compression necessary.  However, the file size will 
be around 40MB per song!)

o WMA – This is Microsoft’s format and is generally smaller than MP3s, 
although not as supported.  Microsoft claims it is ½ the size of an 
equivalent MP3.

o OGG – A royalty and patent free format.  Sound quality is great even at 
low bit rates!  (Encoding to OGG is slow, but the quality is great!)

o Settings – This will allow you to adjust more settings for the format you 
are ripping to, including the tag type.  



Sound Scan Preferences
MP3 CD Burner will constantly be adding new songs into your Music Library found 
on your computer’s hard drive.  These options allow you to set the parameters of 
what gets ‘imported’ into your library. ( Note that there is a big difference in the way 
3.0 and 4.0 worked.)

Types of Songs
Click the type and minimum length of the files that you’d like to add.  For now, you 
can choose to import MP3, WAV, OGG & WMA files.  (Note that it only supports 
non-DRM protected WMA files.)

Where should the scan for new songs?
This allows you to specify the folders to scan for new songs that you may have 
downloaded, created or ripped.  (Songs ripped with MP3 CD Burner are 
automatically added to the library)

• Search entire computer
MP3 CD Burner will search the rest of your computer for music files.  This 
includes all hard drives and any networked drives, as well.  In this mode, it 
searches your entire computer.  You can specify directories to not search in 
this mode. 

o Search network drives
MP3 CD Burner will search any networked drives.  You may want to 
turn this off if you find that your imports are taking longer and you don’t 
really care about searching networked drives. 

o Search on my desktop
Your desktop and sub folders on the desktop will be searched for new 
music files.

o View Exclude List
This brings a list of directories that you do not want to search for new 
songs.  Examples would include temporary directories, game folders.  
If you want to speed up your search add as many directories as you 
can think of, especially larger directories. ( Note that if you had a root 
directory such as "C", this will not search C or any folders under C 
which might not be the intended result!) 

• Search these folders ONLY
This allows you to add directories to search.  The sound scan will search 
these directories and all subdirectories under them.  For example, if all of your 
music was in "C:\My Music" in sub-directories such as "C:\My Music\Artist1" 
and "C:\My Music\Artist2\", etc., you’d add this "C:\My Music\".  The sound 
scan would search this folder and all sub-directories.  The order is important 
and it will start searching in the top directory and finish with the last.



o Suggest Folders…
These will scan your computer for folders that contain the word "mp3", 
"music" and add them automatically to the directory list.  (This can be 
very useful and it’s quick.)

o Up, Down, Remove, Add
These buttons allow you to re-arrange the list of folders.



Remote Database Preferences
The remote database is freedb.org .  It is a FREE online database of 1000’s and 
1000’s or CD albums and track information.   When you put a CD in your CD drive, 
our software queries the database in order to get the artist, album and track 
information.  

MANY, MANY thanks to the people and volunteers behind freedb.org!  

Automatically get album information
This option will cause MP3 CD Burner to query freedb.org as soon as a new CD is 
put in a CD drive.  It will cause your computer to dial or connect to the Internet.  If 
you do want it to look up the information automatically, uncheck this option.

Update site list
There are many mirrors of the freedb.org database hosted around the world.  It is 
possible that freedb.freedb.org is too far from your location and does not always 
establish a connection.   
Click this button to retrieve a full list of official freedb sites hosted around the world.

Use this freedb site
Select the site from which you’d like to retrieve album, artist and track information 
for your CDs.  If you only see one site, click the "Update site list".  You will see a 
short description and location of the site when you click on the site.



Supported CD Recorders
Acoustica MP3 CD Burner supports many CD recorders.  If your recorder is a new 
model and is not automatically supported, we may have released an updated version 
that supports your recorder.  To check for a new version select "Check For New 
Version" from the "Help" menu in Acoustica MP3 CD Burner.  (The best way to tell if 
your CD recorder is supported is to just run our Acoustica MP3 CD Burner on the 
machine.)

The latest list of supported recorders can be found at 
http://www.acoustica.com/mp3-cd-burner/support/supportedcdrs.htm 

CD Text Supported Recorders
IMPORTANT: CD-Text is not available if you are using the Gear engine.

CD-Text supported recorders (Assuming you are using the Goldenhawk CD burning engine.  See above)

Hewlett Packard 7500 / 8100 / 8200 / M820e / 9100 / 9200 

Plextor 4220T (requires firmware 1.02 or higher) 

Plextor 8220T 

Ricoh 7040 (requires firmware 1.20 or higher) 

Ricoh 7060 / 7080 / 8040 / 9060 

Sony CRX100E / CRX110E / CRX120E / CRX140E / CRX140S 

Teac CD-R56S / CD-R58S (requires firmware 1.0J or higher)

Note that other recorders may support CD-Text although not mentioned in this help 
document.
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How to uninstall Acoustica MP3 CD Burner

To uninstall Acoustica MP3 CD Burner, make sure to exit Acoustica MP3 CD Burner 
if you are in it.  

Click the Window’s "Start" button, followed by "Programs", followed by "Acoustica 
MP3 CD Burner", followed by "Uninstall".

Follow the instructions and the software will be removed from your system.



Creating an 80 Minute CD
First, make sure that your CD-recorder supports 80-minute audio CDs.  Not all 
CD-recorders support 80 minute CD-Rs!  If you are not sure, consult your 
CD-recorder’s documentation or visit the manufacturer’s website for help.

If the software does not properly recognize that there is an 80-minute CD-R in the 
drive, click the "Size" control on the "Song List" window and set it to "80 min".

IMPORTANT: You must put an 80 minute CD-R in the drive.  Some CD-recorders 
only record up to 78 minutes 30 seconds.  When you find out how much audio your 
recorder supports, make sure to not go over the limit or your burn may fail and you 
may end up with an unusable CD.



CD Burning Problems
It won't finish the burn or test!  You end up with an unusable CD! 
The burn fails right after it has started burning the first track (Try turning off ‘Auto 
insert notification)! 
I've tried everything. What else can I do to get it to burn successfully?  
It fails right after the burn/test starts!  

It won’t finish the burn or test!  You end up with an unusable CD!  What’s 
happening and what can you do about it?

It is crucial to not use any software when burning or test-burning an audio CD.  The 
CD recorder must have a non-interruptible stream of audio data.  If it is interrupted 
the burn will fail.  

Here’s what you can do to avoid a failed burn or test-burn.

• Try test burns before doing actual burns!

• Enable "Burn-Proof" in the Preferences (CD/DVD Recorder) if available!  
(This is enabled by default.)

• Lower your burn speed.  Your computer may not be able to keep up with 
the demands of your CD recorder.  For example, if you are burning at 8X, 
reduce it to 4X.  Disable virus checkers and screen savers. 

• Select the "Convert to wav files first" option on the Burn window.

• Do not use any other programs during a burn.

• Do not use your computer during a burn.

• Make sure that your computer is well ventilated.  CD Recorders can 
overheat. 

Burn Fails - How to turn off ‘Auto insert notification’  
You may need to disable something called "Auto Insert Notification" (AIN) for your 
CD recorder.  The problem is that when the table of contents is being recorded, 
Window’s suddenly "sees" the new CD and tries to read it, which can cause the 
burn to fail.

To disable Auto Insert Notification, click the Preferences menu item from the File 
menu.  Uncheck the "Auto Insert Notification" item and click OK.  You will have to 
reboot.  



Note that after disabling AIN, when you put a CD into your drive, it will not recognize 
it unless you go to My Computer and double click the CD drive.

You can always turn AIN back on by re-checking the AIN checkbox.  Also, when you 
uninstall MP3 CD Burner it will reset AIN to the original setting.

I’ve tried everything. What else can I do to get it to burn successfully?  
1. Go into your System Control Panel by clicking the Start button, followed by 

"Settings" followed by "Control Panels".  Then double click the "System" 
control panel to bring it up.  Click on the "Device Manager" tab.

2.   
Click the + next to "CDROM"

3.
Your CD drive or drives will look different.  Select your CD-recorder and 
then click the "Properties" button.



4.   
The properties page will appear.  Click on the "Settings" tab.  If you see the 
"DMA" option checked, uncheck it and then click "OK". (You may have to 
reboot.)

5. Also, if you have a SCSI CD recorder, you can improve the efficiency of 
SCSI recorders by making sure "Disconnect" and "Sync data transfer" is 
checked.  Click "OK" and you may have to re-boot.

It fails right after the burn/test starts!
Here are some things to try.

• Uncheck "CD Text" on the "Burn Audio CD!" window if the option is 
checked.

• Disable "Auto Insert Notification" 



Ripping Problems
I cannot see a CD tab to rip from! 
Skips and pops are in my ripped tracks! 

I cannot see a CD tab to rip from!
This is most likely because you do not have an ASPI layer properly installed.  Rerun 
the installer and reboot.  

Skips and pops are in my ripped tracks!
Older CD drives (readers) do not have the ability to seek properly to a position on a 
CD and, thus, if they get out of sync, it will produce a pop in the audio.  Here are 
some things to try.

• Make sure the CD is clean and does not have scratches on it.  (It may be 
permanently damaged and there may be no way to avoid the pop.)

• Try turning the "Jitter" setting to "ON" in the Preferences on the "Ripping 
Tracks" section.  (Ripping may be more accurate, but slower.)

• Try ripping the CD on another CD drive if you have more than one.

• Shut down other programs, including screensavers and virus checkers to free 
up your computer’s resources.

• Try ripping to WAV format, instead of MP3, OGG or WMA.  (This requires less 
computer power.)

• Change your ASPI layer.  (This only applies if you are using the Goldenhawk 
Rip/Burn engine.)  If you are using the Acoustica ASPI, try un-checking it to 
use the default Window’s ASPI layer.

• Try purchasing and installing a new CD Drive.  (Writers and readers are pretty 
inexpensive these days.)

• Contact our support staff @ 
http://www.acoustica.com/mp3-cd-burner/support.htm 



Playback Problems
The CD has recorded successfully, but won't play in my home or car stereo CD 
player! 
I can't hear any audio when I try to play songs within Acoustica MP3 CD Burner! 
My MP3 CD is playing tracks back in the wrong order! 

The CD recorded successfully, but it won’t play in my home or car stereo CD 
player!  Did you make sure to use a CD-R disc?  Many people mistakenly use a 
CD-RW.  Some newer audio CD players will support CD-RWs, but when in doubt 
use a CD-R!

If you burned a MP3 CD, you will not be able to play it in an older CD player.  The 
CD player needs to have the MP3 logo or it must be capable of playing MP3 or 
WMA files!

I can’t hear any audio when I try to play songs within Acoustica MP3 CD 
Burner!
You need to check the following settings.

• Make sure your speakers are plugged in, turned on and connected to your 
computer!  (This happens to the best of us. �)

• Check your Window's volume mixer and make sure that the Wave volume 
and Master volume are up and not muted.

• Make sure you have the updated and latest sound drivers which you can 
get and install from your soundcard’s manufacturers website.   After 
installing the new soundcard drivers, you may need to re-boot.

My MP3 CD is playing tracks back in the wrong order!
MP3 CDs can fit many MP3s and WMA files on to a single CD or DVD.  However, 
MP3 CD players play the songs in alphabetical order!  If these tracks are chapters in 
an audio book, it will play in the wrong order!  Make sure to go into the MP3 CD 
wizard and select "Specify".  On page 5, you’ll need to set it to preserve the file 
order.  You’ll need to burn a new CD after these settings have been applied.



General Questions
How many songs can be burned on a CD? 
Once I burn a CD, can I burn more songs on it later? 
In the Find interface, can I search for a directory or a special programs MP3 files? 
What type of blank media should I burn or record to? 

How many songs can be burned on a CD?
You can have a maximum of 100 songs on a CD.  However, most people will be able 
to add about 13 – 20 songs per CD.  The main limit is that a CD can only hold 74 or 
80 minutes of audio.   (Time limit depends on the actual physical CD-R disc.  Some 
support 74 minutes and some support 80 minutes.  Burning an 80-minute CD-R 
requires that your CD-Recorder hardware supports it.)

Once I burn a CD can I burn more songs on it later?
No. Acoustica MP3 CD Burner burns in Disc-At-Once mode and always closes the 
session at the end of burning the disc.  You should have all your songs arranged 
before burning.  

In the Find interface, can I search for a directory or a special programs MP3 
files?
If your songs are stored in a folder called "My Music" and you just want to find all of 
those songs.  Just enter "my music" into the "Search For" field and then press the 
"Search" button.

If you are looking for songs created by a special program and they are stored in a 
special directory such as "Audiocatalyst", you can search on ‘audiocatalyst’.

What type of blank media should I burn or record to?
If you want it to be usable on any standard home or car stereo, you should use a 
blank CD-R disc.  (You can use CD-RW, but they are only supported on some of the 
more modern audio CD players.)


